
Version 4.1

Guide Draw

Chapitre 6 

Éditer des images

LibreOffice est une marque déposée de The Document Fondation
Plus d’informations sur fr.libreoffice.org

http://fr.libreoffice.org/


Copyright

Ce document est Copyright © 2010–2014 par ses contributeurs tels que listés ci-dessous. Vous 
pouvez le distribuer et/ou le modifier sous les termes des licences GNU General Public License 
(http://www.gnu.org/licenses/gpl.html), version 3 ou ultérieure ou Creative Commons Attribution 
License (http://creativecommons.org/licenses/by/3.0/), version 3.0 ou ultérieure.

Tous les noms de marque à l'intérieur de ce guide appartiennent à leur propriétaire légitime.

Contributeurs
Auteur : Christian Chenal

Relecteurs : Pierre-Yves Samyn

Retours
Veuillez envoyer vos commentaires ou suggestions à propos de ce document à : 
doc@fr.libreoffice.org

Remerciements
Ce chapitre est basé sur le guide Prise en main de Draw de Michel Pinquier et sur les Chapitres 6 
de OpenOffice.org 3.3 Draw Guide (anglais) et LibreOffice 4.1 Draw Guide (anglais). Les 
contributeurs à ces chapitres sont :

Michel Pinquier Alex Thurgood Jim Taylor Linda Worthington
Daniel Carrera Jean Hollis Weber Agnes Belzunce Wolfgang Uhlig
Martin Fox Peter Hillier-Brook Hazel Russman Gary Schnabl
Claire Wood John Cleland John A Smith Peter Schofield

Date de publication et version du logiciel
Publié le 24 février 2014. Basé sur LibreOffice 4.1.2.

Apparence de LibreOffice

LibreOffice fonctionne sous les systèmes d'exploitation Windows, Linux et Mac OS X, chacun de 
ces systèmes pouvant exister sous plusieurs versions. Chacune de ces configurations peut donner
lieu à des options d'affichage différentes (polices, couleurs, thèmes, gestionnaire de fenêtres, 
icônes). De plus, ces options d'affichage sont pour certaines personnalisables par les utilisateurs.

Les illustrations de ce chapitre ont été réalisées sous Windows avec le jeu d'icônes Galaxy. 
Certaines images ne ressembleront donc pas exactement à ce que vous voyez sur votre 
ordinateur. En cas de confusion sur une icône, dont l'apparence peut être très différente d'un jeu à 
l'autre, vous pouvez vérifier son nom, qui apparaît dans l'infobulle lorsque vous placez le pointeur 
de la souris au-dessus.
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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Introduction

Les précédents chapitres du guide Draw ont traité uniquement des formes vectorielles. Toutefois, 
Draw dispose d'un certain nombre de fonctions destinées aux images (bitmaps) telles que les 
photographies et les images scannées, et notamment l'import, l'export et la conversion d'un format 
à un autre.

Draw est capable de lire la majorité des formats de fichiers graphiques. Il dispose d'un ensemble 
de possibilités comparable à ceux de logiciels spécialisés de traitement d'image, comme Adobe 
Photoshop ou Gimp.

Importer des images

Insertion
Pour importer des fichiers graphiques dans votre dessin, choisissez Insertion > Images > À partir

d'un fichier depuis la barre de menus ou cliquez l'icône À partir d'un fichier  de la barre 
d'outils Dessin. La boîte de dialogue Insérer une image s'ouvre (Figure 1). L'apparence de cette 
boîte de dialogue peut varier selon votre système d'exploitation et le fait que l'option Utiliser les 
boîtes de dialogue LibreOffice soit cochée ou non dans Outils > Options > LibreOffice > 
Général.

Figure 1 : Boîte de dialogue Insérer une image

Draw comporte des filtres d'import pour la majorité des formats d'images. Si le fichier que vous 
voulez importer a un format d'image non pris en compte par les filtres d'import, il est alors 
recommandé d'utiliser un autre programme de conversion d'images afin d'obtenir un format 
reconnu par Draw.

Si vous cochez l'option Aperçu, un aperçu du fichier apparaît dans la partie droite de la boîte de 
dialogue. Cela facilite le choix du fichier et vous permet également de vérifier que Draw peut bien 
importer le format de fichier utilisé.
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Incorporation
L'incorporation d'une image dans votre dessin fait de cette image un élément permanent de votre 
document. Toute modification que vous apportez à une image incorporée n'apparaîtra que dans 
votre dessin et le fichier image d'origine ne sera pas affecté.

L'incorporation se produit lorsque vous importez une image dans votre dessin en utilisant la 
commande Insérer une image sans l'option Lier, un copier-coller, le scan d'une image ou un 
glisser-déposer.

Le principal avantage des images incorporées dans votre dessin est que ces images sont 
disponibles quel que soit l'ordinateur utilisé pour ouvrir le document.

Le principal inconvénient des images incorporées est que cela peut créer des fichiers de taille 
importante, ce qui peut être gênant si vous n'avez qu'une capacité limitée pour stocker vos fichiers.
La fonction de compression d'image peut alors être intéressante : voir "Compression" page 12.  
Un autre inconvénient est que si l'image d'origine est modifiée, votre dessin ne disposera pas 
d'une version à jour de cette image à chaque fois que vous l'ouvrirez.

Note
Il est possible que, lors de l'incorporation, un fichier image change de format : c'est le
cas notamment pour les fichiers au format DXF ou SVG.

Lien
Le lien d'une image dans votre dessin ne va pas l'insérer dans votre document, mais un lien est 
créé vers l'endroit où le fichier image se trouve sur votre ordinateur. À chaque fois que votre 
document sera ouvert, toutes les images liées seront affichées dans votre dessin.

Le principal avantage est que si l'image d'origine est modifiée ou remplacée par une autre image 
avec le même nom de fichier, la fois suivante où vous ouvrirez votre document, la dernière version 
de l'image apparaîtra dans le dessin.

Le principal inconvénient est que le lien entre votre dessin et les fichiers images doit être maintenu
pour que la liaison fonctionne correctement. Si vous envoyez votre document vers un autre 
ordinateur, vous devez également envoyer les fichiers liés, et dans le même dossier que sur 
l'ordinateur d'origine.

Pour lier un fichier image dans votre dessin, cochez l'option Lier dans la boîte de dialogue Insérer 
une image (Figure 1) avant de cliquer sur le bouton Ouvrir. Un message d'avertissement peut 
apparaître, vous demandant de confirmer la liaison ou d'incorporer l'image.

Toute modification d'une image liée à l'intérieur de votre document n'apparaîtra que dans votre 
dessin et le fichier image d'origine ne sera pas affecté.

Les liens peuvent être actualisés, modifiés ou rompus en choisissant Édition > Liens depuis la 
barre de menus pour ouvrir la boîte de dialogue Éditer les liens (Figure 2). Sélectionnez le lien à 
actualiser, à modifier ou à rompre, puis cliquez sur le bouton correspondant. Si vous rompez un 
lien, l'image devient incorporée dans votre dessin.
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Figure 2 : Boîte de dialogue Éditer les liens

Scan
Avec la plupart des scanners, vous pouvez directement insérer une image scannée dans votre 
dessin. Les images scannées sont incorporées au format PNG.

Assurez-vous que votre scanner est configuré sur l'ordinateur et qu'il supporte le système SANE 
pour le système d'exploitation Linux, ou TWAIN pour les systèmes d'exploitation Windows ou Mac.

Pour insérer une image depuis un scanner :

1) Placez le document, le dessin ou la photographie dans le scanner et assurez-vous que le 
scanner est prêt.

2) Choisissez Insertion > Image > Scanner > Sélectionner la source depuis la barre de 
menus pour sélectionner le scanner à utiliser. Choisissez Insertion > Image > Scanner > 
Acquérir depuis la barre de menus une fois le scanner sélectionné.

3) La suite de la procédure dépend du pilote du scanner, de son interface et du système 
d'exploitation de l'ordinateur. Il vous est habituellement demandé de spécifier les options 
de scan, comme la résolution ou la fenêtre de scan entre autres. Consultez la 
documentation de votre scanner pour plus d'informations.

4) Une fois l'image scannée, Draw la place dans votre dessin. Vous pouvez alors l'éditer 
comme n'importe quelle autre image.

Copie et collage
Copier une image puis la coller est une autre façon d'incorporer des images dans votre dessin, qui 
passe par le presse-papiers. L'image copiée peut être une image déjà incorporée dans un autre 
document, ou ce peut être un fichier image.

Après la copie, vous pouvez choisir le format dans lequel vous voulez coller l'image dans Draw en 
choisissant  Édition > Collage spécial depuis la barre de menus. Les formats disponibles 
dépendent du type d'image copiée dans le presse-papiers.
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Glisser-déposer
Le glisser-déposer est une autre méthode pour incorporer des images dans un dessin et peut être 
utilisé avec des images incorporées ou liées à l'origine. La façon dont le glisser-déposer fonctionne
dépend du système d'exploitation de l'ordinateur. Le comportement du glisser-déposer est 
habituellement possible en utilisant les touches Ctrl ou Ctrl+maj en combinaison avec la souris.

Les images fréquemment utilisées peuvent être rangées dans la Gallery de LibreOffice. Une copie 
de l'image peut alors être simplement glissée-déposée dans le dessin depuis la Gallery. Voir le 
Chapitre 10 Techniques avancées de Draw pour plus d'informations.

Insertion de fichier
L'option Insertion > Fichier est disponible depuis la barre de menus. Elle vous permet d'insérer 
un fichier qui est un dessin Draw (*.odg), une présentation Impress (*.odp), ou du texte à partir 
d'un document au format RTF, HTML ou texte brut.

Lorsque vous insérer un fichier, il est habituellement inséré en entier dans votre dessin. 
Cependant, si vous avez choisi un fichier Draw ou Impress, vous pouvez également choisir 
d'insérer individuellement des diapos ou des objets dans votre dessin.

Après avoir sélectionné un fichier Draw ou Impress, et cliqué sur Insérer, la boîte de dialogue 
Insérer des pages/des objets s'ouvre (Figure 3). Pour accéder aux diapos et aux objets individuels,
cliquez sur le symbole d'extension à gauche du nom du fichier (habituellement un + ou un petit 
triangle selon votre système d'exploitation). Sélectionnez les diapos et les objets que vous voulez 
insérer et cliquez sur OK.

Figure 3 : Insérer des diapos et des objets

Vous pouvez insérer les éléments en tant qu'objets incorporés ou liés si vous cochez l'option Lier. 
L'option Supprimer les arrière-plans inutilisés vous permet de ne pas insérer les pages maîtresses 
inutilisées.

Si l'objet inséré était nommé dans le document source, il conserve son nom d'origine, à moins que 
que ce nom existe déjà dans le document cible. En cas de conflit, vous devez renommer l'objet 
avant qu'il ne soit inséré. Pour renommer un objet inséré, faites un clic droit et choisissez Nom 
dans le menu contextuel. Ceci présente l'avantage que l'objet soit alors listé dans le Navigateur.
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Exporter des images

Exporter le fichier entier
Par défaut, Draw enregistre les dessins au format ODG, mais certains logiciels ne peuvent pas 
ouvrir ces fichiers. Vous pouvez alors exporter le fichier dans divers formats.

1) Dans votre dessin, ne sélectionnez aucun objet et choisissez Fichier > Exporter depuis la 
barre de menus. La boîte de dialogue Exporter s'ouvre (Figure 4).

Figure 4 : Exporter un document Draw

2) Sélectionnez le format désiré dans la section supérieure de la liste déroulante Format de 
fichier.

3) Cliquez sur Exporter.

4) Selon le format sélectionné, une autre boîte de dialogue peut s'ouvrir pour vous demander 
de spécifier les options nécessaires à ce format graphique.

5) Cliquez sur Exporter, Créer ou OK et votre document sera exporté en tant que nouveau 
fichier dans un nouveau format.

Note
Les formats situés dans la section supérieure de la liste déroulante Format de fichier 
(HTML, XHTML, PDF et SWF) ne s'appliquent qu'à des documents entiers.

Exporter des objets
Pour exporter des objets individuels de votre document :

1) Dans votre dessin, sélectionnez les objets que vous voulez exporter et choisissez Fichier 
> Exporter depuis la barre de menus. La boîte de dialogue Exporter s'ouvre (Figure 4).

2) Sélectionnez le format désiré dans la section inférieure de la liste déroulante Format de 
fichier.

3) Cochez l'option Sélection.

4) Cliquez sur Exporter.

5) Selon le format sélectionné, une autre boîte de dialogue peut s'ouvrir pour vous demander 
de spécifier les options nécessaires à ce format graphique.

6) Cliquez sur Exporter, Créer ou OK et les objets sélectionnés seront exportés en tant que 
nouveau fichier dans un nouveau format. Les images seront exportées avec les filtres que 
vous leur avez appliqués dans le document (rognage…).
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Enregistrer des images
Vous pouvez enregistrer une image d'origine (sans les filtres que vous lui avez appliqués dans le 
document comme le rognage) contenue dans votre dessin en tant que fichier individuel. Pour ceci :

1) Sélectionnez l'image que vous voulez enregistrer, faites un clic droit et choisissez 
Enregistrer l'image dans le menu contextuel. La boîte de dialogue Export d'images 
s'ouvre (Figure 5).

Figure 5 : Boîte de dialogue Export d'images

2) Spécifiez le nom du fichier dans la zone Nom de fichier.

3) Choisissez le format d'image dans la liste déroulante Type de fichier.

4) Cliquez sur Enregistrer pour enregistrer l'image en tant que nouveau fichier.

Formater des images

Les objets de type image peuvent être formatés en utilisant le menu Format ou le menu contextuel.
La barre d'outils Image est utilisée pour appliquer ou modifier des filtres, et pour ajuster les 
propriétés des lignes, des zones et des ombres.

Les images sont des objets, pour lesquels s'appliquent les fonctionnalités décrites dans les autres 
chapitres de ce guide. Elles peuvent être incluses dans un groupe et réagir comme les autres 
objets lorsque les propriétés du groupe sont modifiées.

Les propriétés de transparence du menu Format ne font pas référence à la transparence de 
l'image elle-même, mais à celle de sa zone en arrière-plan. Pour modifier la transparence d'une 
image, vous devez utilisez la barre d'outils Image : voir "Barre d'outils Image" page 12.
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Les images peuvent être renversées (Modifier > Refléter depuis la barre de menus), mais 
certaines images au format métafichier (metafile) peuvent poser problème lors de l'exécution de 
cette commande si elles contiennent du texte.

Taille d'origine
Réinitialise les dimensions de l'image avec les valeurs telles qu'elles étaient définies lors de 
l'insertion de l'image.

Nom
Il est recommandé de renommer les images en utilisant Modifier > Nom depuis la barre de menus
ou en faisant un clic droit et en choisissant Nom dans le menu contextuel. Seuls les objets 
nommés sont visibles dans le Navigateur et peuvent être importés directement depuis un autre 
fichier.

Description
Vous pouvez ajouter, en tant que métadonnées, un titre et une description à l'image. Cette 
information est utilisée par les outils d'accessibilité (comme un logiciel de lecture d'écran) et en 
qualité d'attributs de type ALT (alternatifs) si vous exportez le document en HTML.

Compression
Vous pouvez compresser une image afin de diminuer la taille de votre document. Pour ceci, 
sélectionnez l'image, faites un clic droit et choisissez Compresser l'image dans le menu 
contextuel. La boîte de dialogue qui s'ouvre affiche les tailles et résolution originales et affichées 
dans le document, ainsi que la qualité de l'image exprimée en kibioctets.

Vous pouvez choisir entre une compression JPEG et une compression sans perte (PNG), avec à 
chaque fois la possibilité de saisir le niveau de qualité ou de compression. Vous pouvez également
modifier la taille et la résolution de l'image en choisissant un algorithme d'interpolation.

Une fois ces modifications saisies, utilisez le bouton Calculer pour calculer la nouvelle qualité de 
l'image. Vous pouvez valider ces modifications en cliquant sur OK.

Édition avec un outil externe
Vous pouvez éditer une image avec un outil externe, afin de disposer de fonctionnalités plus 
avancées. Pour ceci, sélectionnez l'image, faites un clic droit et choisissez Éditer avec un outil 
externe dans le menu contextuel.

Barre d'outils Image

La barre d'outils Image apparaît automatiquement lorsque vous sélectionnez une image (Figure 6 
et Figure 7).

Figure 6 : Barre d'outils Image
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Figure 7 : Outils de la 
barre d'outils Image

Les outils disponibles dans la barre d'outils Image sont les suivants :

• Filtrer : ouvre la barre d'outils Filtre graphique décrite dans le paragraphe "Barre d'outils 
Filtre graphique" page 15.

• Mode Graphique : modifie l'affichage de l'image. Ce paramètre n'affecte que l'affichage et 
l'impression de l'image : le fichier image d'origine, incorporé dans le document ou lié, reste 
inchangé.

– Par défaut : l'image est affichée sans modification de couleur.

– Niveaux de gris : l'image est affichée avec 256 niveaux de gris.

– Noir/Blanc : l'image est affichée en noir et blanc

– Filigrane : la luminosité et le contraste de l'image sont réduits afin qu'elle puisse être 
utilisée en tant que filigrane (arrière-plan).

• Couleur : ouvre la barre d'outils Couleur (Figure 8), qui permet d'ajuster les valeurs des 
trois couleurs RVB, la luminosité, le contraste et le gamma. Ces modifications n'affectent 
pas l'image d'origine, mais les valeurs d'ajustement sont enregistrées dans Draw en tant 
que paramétrage séparé.

Figure 8 : Barre d'outils Couleur

– Rouge, Vert, Bleu : permet de sélectionner des valeurs entre -100 % (pas de couleur) 
et 100 % (intensité totale) ; 0 % représente la valeur d'origine de la couleur dans 
l'image.

– Luminosité : permet de sélectionner une valeur entre -100 % (totalement noir) et 
100 % (totalement blanc).
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– Contraste : permet de sélectionner une valeur entre -100 % (minimum) et 100 % 
(maximum).

– Gamma : permet de sélectionner une valeur entre 0,1 et 10 pour modifier la 
luminosité des couleurs intermédiaires. Essayez d'ajuster cette valeur si les 
modifications de luminosité et de contraste ne vous produisent pas le résultat espéré.

• Transparence : définit le degré de transparence de l'image entre 0 % (opaque) et 100 % 
(totalement transparente).

• Ligne : ouvre la boîte de dialogue Ligne. Dans ce contexte, la ligne concernée est celle qui
entoure l'image.

• Remplissage : ouvre la boîte de dialogue Remplissage pour modifier la couleur, le 
dégradé, la hachure et l'image bitmap de la zone en arrière-plan qui contient l'image, et 
non de l'image elle-même. Pour voir cet arrière-plan, vous devez fixer la valeur de 
transparence de l'image à un niveau suffisamment élevé.

• Ombre : permet d'obtenir un effet d'ombre autour de l'image.

• Rogner l'image : permet de rogner l'image. Lorsque vous cliquez sur cette icône, des 
poignées rouges de rognage apparaissent autour de l'objet. Faites-les glisser pour rogner 
l'image à la taille désirée. Pour un rognage plus précis, voir "Rognage" page 14.

• Effets, Alignement et Disposer : leur utilisation est la même que pour les autres objets. 
Voir les Chapitres 4 Modifier les attributs d'un objet et 5 Combiner plusieurs objets.

Rognage

Pour plus de contrôle et de précision sur les fonctions de rognage, sélectionnez l'image et 
choisissez Format > Rogner l'image depuis la barre de menus, ou faites un clic droit et 
choisissez Rogner l'image dans le menu contextuel, pour ouvrir la boîte de dialogue Rogner 
(Figure 9).

Figure 9 : Boîte de dialogue Rogner
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Toute modification effectuée dans la boîte de dialogue Rogner ne change que l'affichage de 
l'image. L'image d'origine n'est pas modifiée. Si vous voulez exporter une image rognée, vous 
devez le faire en utilisant Fichier > Exporter. Si vous choisissez Enregistrer l'image dans le 
menu contextuel, c'est l'image d'origine qui sera exportée.

Dans la boîte de dialogue Rogner, un aperçu vous permet de vous rendre compte de la façon dont 
l'affichage de l'image sera modifié en conséquence des valeurs des différents paramètres.

Rogner
Cette section vous permet de découper l'image sélectionnée, ou d'ajouter un espace vide autour 
de cette image.

• Conserver l'échelle : conserve l'échelle d'origine de l'image lors du rognage, ce qui a pour
conséquence que la taille de l'image va évoluer.

• Conserver la taille de l'image : conserve la taille d'origine de l'image lors du rognage, ce 
qui a pour conséquence que l'échelle de l'image va changer.

• Gauche et Droite : saisissez une valeur positive pour réduire l'image du côté gauche ou 
droit, ou une valeur négative pour ajouter un espace vide du côté gauche ou droit de 
l'image. Si Conserver l'échelle est cochée, la largeur de l'image sera diminuée ou 
augmentée de cette valeur. Si Conserver la taille de l'image est cochée, l'échelle 
horizontale sera augmentée ou diminuée en conséquence.

• Haut et Bas : saisissez une valeur positive pour réduire l'image du côté haut ou bas, ou 
une valeur négative pour ajouter un espace vide du côté haut ou bas de l'image. Si 
Conserver l'échelle est cochée, la hauteur de l'image sera diminuée ou augmentée de 
cette valeur. Si Conserver la taille de l'image est cochée, l'échelle verticale sera 
augmentée ou diminuée en conséquence.

Échelle
Cette section vous permet de modifier l'échelle de l'image sélectionnée. Dans les champs Largeur
et Hauteur, saisissez sous forme de pourcentage la valeur d'échelle pour la largeur et la hauteur 
de l'image.

Taille de l'image
Cette section vous permet de modifier la taille de l'image sélectionnée. Dans les champs Largeur 
et Hauteur, saisissez la largeur et la hauteur de l'image.

La taille d'origine de l'image est affichée au-dessus du bouton Taille d'origine. Cliquez sur ce 
bouton pour réinitialiser l'image à une échelle de 100 % et à ses largeur et hauteur d'origine (en 
tenant compte des valeurs de la section Rogner).

Attention
Faites attention avec les opérations de rognage. Dans la boîte de dialogue Rogner, 
les valeurs de largeur et de hauteur des sections Échelle et Taille de l'image peuvent 
être manipulées de façon indépendante. Changer une valeur sans changer l'autre 
peut aboutir à des déformations importantes de l'image, ce qui peut ne pas être ce 
que vous avez recherché dans ces opérations de rognage.

Barre d'outils Filtre graphique

Après la sélection d'une image et l'ouverture de la barre d'outils Image (Figure 6), cliquez sur 

l'icône Filtrer  pour ouvrir la barre d'outils Filtre graphique. Draw vous propose onze effets de 
filtre. Les filtres s'appliquent à l'affichage en cours d'une image et peuvent être combinés. Ils 
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s'appliquent toujours à l'image en entier : il n'est pas possible d'utiliser les filtres pour éditer une 
partie d'une image seulement.

Si votre image est liée, tous les filtres graphiques utilisés ne sont appliqués qu'à l'affichage en 
cours. L'image originale n'est pas modifiée. Lorsque vous fermez le dessin, tous les filtres qui ont 
été appliqués sont perdus. Pour conserver une copie de l'image filtrée, exportez ou enregistrez 
l'image (Fichier > Exporter ou clic droit et Enregistrer l'image).

Si votre image est incorporée, tous les filtres graphiques sont appliqués directement sur cette 
image et ne peuvent être annulés au cours d'une session ultérieure. Une fois le dessin enregistré 
et fermé, les effets des filtres graphiques deviennent permanents. Si vous voulez annuler l'effet 
d'un filtre graphique, vous devez utiliser Édition > Annuler avant de fermer le fichier.

Figure 10 : Barre d'outils Filtre graphique

Figure 11 : Outils de la barre 
d'outils Filtre graphique

Filtre graphique Invertir

Le fait de cliquer sur l'icône Invertir  va invertir ou inverser les valeurs de couleurs et de 
luminosité d'une image, comme pourrait le faire un négatif photographique (Figure 12).

Figure 12 : Image invertie
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Filtre graphique Adoucir

Le fait de cliquer sur l'icône Adoucir  va adoucir ou estomper l'image, en appliquant un filtre de 
basse fréquence qui va réduire le contraste entre des pixels voisins et produire une légère perte de
contraste (Figure 13). La boîte de dialogue Adoucir (Figure 14) s'ouvre, où vous pouvez déterminer
le rayon lisse à appliquer au filtre lorsque vous cliquez sur OK : plus la valeur est forte, plus 
l'image sera floue.

Figure 13 : Image adoucie

Figure 14 : Boîte de dialogue Adoucir

Filtre graphique Augmenter la netteté

Le fait de cliquer sur l'icône Augmenter la netteté  va augmenter la netteté de l'image, en 
appliquant un filtre de haute fréquence qui va augmenter le contraste entre des pixels voisins en 
élevant la différence de luminosité. Cela va accentuer les lignes et cet effet sera renforcé si vous 
appliquez le filtre plusieurs fois (Figure 15).

Figure 15 : Image avec netteté augmentée
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Filtre graphique Supprimer les interférences

Le fait de cliquer sur l'icône Supprimer les interférences  supprime les interférences, en 
appliquant un filtre médian qui compare chaque pixel à ses voisins. Il remplace alors les pixels 
dont les valeurs de couleur s'écartent le plus des valeurs moyennes par des pixels avec ces 
valeurs de couleur moyennes. Le résultat produisant des variations de contraste plus faibles, 
l'image paraît plus douce (Figure 16).

Figure 16 : Image avec interférences
supprimées

Filtre graphique Solarisation
La solarisation est un phénomène en photographie par lequel les couleurs d'une image enregistrée
sur un négatif ou imprimée sont totalement ou partiellement inversées. C'était à l'origine un effet 
photochimique utilisé durant le développement d'un film photographique. La solarisation est 
maintenant utilisée dans l'univers de l'image numérique pour créer une modification ou une 
inversion de couleurs (Figure 17).

Figure 17 : Image solarisée

Figure 18 : Boîte de dialogue Solarisation
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Le fait de cliquer sur l'icône Solarisation  ouvre la boîte de dialogue Solarisation (Figure 18). 
Saisissez une valeur de seuil de la couleur à partir de laquelle celle-ci est inversée. Cochez 
l'option Invertir pour ajouter un effet invertir à l'image (voir "Filtre graphique Invertir" page 16).

Filtre graphique Vieillissement
Le vieillissement crée une apparence qui ressemble aux photographies anciennes. Tous les pixels 
sont fixés à leur valeur de gris et les canaux de couleur verte et bleue sont réduits à la valeur 
déterminée dans la boîte de dialogue Vieillissement. Le canal de couleur rouge n'est pas modifié 
(Figure 19).

Le fait de cliquer sur l'icône Vieillissement  ouvre la boîte de dialogue Vieillissement (Figure 
20), où vous pouvez choisir le degré de vieillissement : à 0 %, on ne voit que les valeurs de gris 
des pixels ; à 100 %, il ne reste que le canal rouge.

Figure 19 : Image vieillie

Figure 20 : Boîte de dialogue Vieillissement

Filtre graphique Poster
L'effet de poster réduit le nombre de couleurs d'une image, la rendant plus plate. Si vous l'utilisez 
sur une photographie, celle-ci ressemblera à une peinture (Figure 21).

Le fait de cliquer sur l'icône Poster  ouvre la boîte de dialogue Poster (Figure 22), où vous 
pouvez choisir le nombre de couleurs.

Barre d'outils Filtre graphique 19



Figure 21 : Image avec effet poster

Figure 22 : Boîte de dialogue Poster

Filtre graphique Pop'art

Le fait de cliquer sur l'icône Pop'art  va modifier les couleurs de l'image pour la mettre au 
format pop-art (Figure 23).

Figure 23 : Image pop-art

Filtre graphique Dessin au fusain

Le fait de cliquer sur l'icône Dessin au fusain  va afficher l'image comme un croquis au fusain. 
Les contours de l'image sont tracés en noir et les couleurs d'origine sont supprimées (Figure 24).
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Figure 24 : Image dessinée au fusain

Filtre graphique Relief
L'effet de relief permet de faire apparaître les lignes d'une image en relief, comme si l'image était 
éclairée par une source de lumière (Figure 25).

Le fait de cliquer sur l'icône Relief  ouvre la boîte de dialogue Relief (Figure 26), où vous 
pouvez choisir la position de la source de lumière qui va créer des ombres.

Figure 25 : Image en relief

Figure 26 : Boîte de dialogue Relief

Filtre graphique Mosaïque
L'effet de mosaïque crée de petits groupes de pixels et les transforme en carreaux rectangulaires 
d'une seule couleur, produisant un image qui ressemble à une mosaïque (Figure 27). Plus les 
rectangles individuels créés sont grands, moins l'image comporte de détails.

Le fait de cliquer sur l'icône Mosaïque  ouvre la boîte de dialogue Mosaïque (Figure 28), où 
vous pouvez déterminer la largeur et la hauteur en pixels des rectangles individuels qui seront 
créés. Le fait de cocher l'option Mise en évidence des arêtes va accentuer les côtés de chaque 
carreau.
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Figure 27 : Image en mosaïque

Figure 28 : Boîte de dialogue Mosaïque

Remplacer des couleurs

L'outil Remplacement de couleurs vous permet de modifier une couleur d'une image, de la 
remplacer par une autre couleur ou de la rendre transparente. Jusqu'à quatre couleurs peuvent 
être remplacées en même temps. L'outil fonctionne sur l'image entière et vous ne pouvez pas 
sélectionner une partie de l'image pour l'éditer.

L'outil Remplacement de couleurs ne peut être utilisé qu'avec des images incorporées. Si vous 
essayez d'utiliser cet outil avec une image liée, lorsque vous cliquez sur le bouton Remplacer, le 
message suivant s'affichera :

La liste de sélection Remplacer par contient toutes les couleurs disponibles de la palette de 
couleurs en cours pour le document. Vous ne pouvez pas ici définir de nouvelles couleurs, mais 
vous pouvez ajouter des couleurs à cette palette avant d'utiliser l'outil. Voir Chapitre 4 Modifier les 
attributs d'un objet.

Pour remplacer des couleurs dans une image, faites comme suit :

1) Sélectionnez Outils > Remplacement de couleurs depuis la barre de menus pour ouvrir 
la boîte de dialogue Remplacement de couleur (Figure 29).

2) Sélectionnez l'image où remplacer des couleurs.

3) Cliquez sur l'icône Pipette  pour activer le mode de sélection de couleur.

4) Déplacez le pointeur de la souris au-dessus de la couleur à remplacer dans l'image et 
cliquez.
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5) Une case est cochée dans la liste des couleurs et la couleur sélectionnée apparaît dans la 
zone Couleur d'origine.

Figure 29 : Remplacement de couleurs

6) Saisissez le pourcentage de tolérance par rapport à la couleur sélectionnée. La valeur par 
défaut est de 10 %.

7) Dans la zone Remplacer par, sélectionnez la couleur de remplacement dans la liste 
déroulante. La valeur par défaut est Transparent.

8) Vous pouvez répéter les étapes 3 à 7 pour remplacer jusqu'à quatre couleurs 
simultanément.

9) Cliquez sur le bouton Remplacer pour procéder au remplacement.

Il n'existe pas d'aperçu de l'effet produit par l'outil de remplacement de couleurs. Si le résultat ne 
correspond pas à vos attentes, faites Édition > Annuler et recommencez.

Le pourcentage de tolérance est utilisé pour indiquer combien de valeurs de couleurs seront 
remplacées. Plus ce pourcentage sera faible, plus les couleurs devront être proches de la valeur 
de couleur sélectionnée pour être remplacées.

Vous pouvez également remplacement la valeur de couleur Transparent par une autre valeur dans
une image. Pour ceci, faites Outils > Remplacement de couleurs, puis sélectionnez l'image. 
Dans la boîte de dialogue Remplacement de couleur, cochez la case Transparence, puis 
sélectionnez la couleur de remplacement dans la liste déroulante. Cliquez alors sur le bouton 
Remplacer.

Conversion

Convertir en bitmap
Tous les objets de dessin situés dans un document LibreOffice Draw sont des graphiques 
vectoriels qui peuvent être convertis en images bitmap au format PNG.

Pour convertir un graphique vectoriel en image bitmap, sélectionnez Modifier > Convertir > En 
bitmap depuis la barre de menus ou faites un clic droit et choisissez Convertir > En bitmap dans 
le menu contextuel.
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